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Introduction 
 
KDP Print is a website you can use to self-publish your paperback for free. You will have to 
format your manuscript before submitting it to KDP Print. This is not a difficult process. 
Here you will learn how to format your manuscript into a book. After your formatting is 
completed, you can submit your manuscript to KDP Print for publication, and it will soon  show 
up for sale in the Amazon marketplace. 



 
 
 

Moving Your Manuscript to the 6x9 Book Template 
 
 

 

You will use a book template to format your manuscript for publication. Before transferring 
your manuscript you should format your book to the best of your ability by making sure that 
the headings are bolded, your lists are numbered, the document is spell checked etc. You will 
want you book to be at least 10 – 12,000 words long. A book of this length will end up being 
about a quarter of an inch thick if it is printed as a standard 6x9 inch book. 

 

To begin, download the KDP Print 6x9 book template, which you can find on the Paper Backs 
Made Easy website, within the How to Format Your Book Manuscript lesson. Open your word 
document as well. Place your cursor anywhere in the document, and then ‘Select All’ by typing 



Ctrl+A. Afterwards type Ctrl+C to copy the text. Next, open up the book template. When you 
first open it up you will notice that pages have been pre-formatted for your title page, copyright 
page, and disclaimer page, and 2nd title page. You will see that a disclaimer is already written 
out for you. You can use this if you would like, and it is probably safe to do so. Ensuring that 
this disclaimer is legally binding is up to you, however, and cannot be guaranteed by this 
website. 

 
 
 

 
 
 

Scroll down the template, and you will see a page labeled “Paste Your Manuscript Here”. It will 
be on the last page. Select this title and then type Ctrl+V in order to paste your manuscript text 
into the KDP Print template. There is a little more formatting to be done after this, but as you 
can see your manuscript is already well on its way to becoming a book. Continue on with the 
lesson to see what other simple changes will need to be made to complete it for submission. 



 



 

Page Size & Margins 
 
Now that you have pasted your manuscript into the template, your book is set up to be a 6x9 
inch paperback book. This is the most common size for paperbacks. If you would like, you can 
change this template in order to make a different-sized book. However, this is the optimum 
size for your submission to KDP Print. 

 

If you were to want to change your book size, simply click the ‘Page Layout’ tab in your Word 
document. Then click on ‘Size’. When you do this you will see a number of defaults pop up in a 
dropdown menu, but none of these actually correspond with the approved book sizes for KDP 
Print. So, scroll down and click on ‘More Paper Sizes’. The Page Setup Menu will then pop up. 



 
 
 

On the Page Setup Menu you will see that in the ‘Width’ and ‘Height’ fields it says 6” and 9”. 
Changing the numbers in these fields will change the proportions of your book. If you want to 
apply these changes, simply click ‘OK’. 

 

You should also understand why the margins are set up the way that they are in this template. 
In looking at the template, you will probably notice that the outside margins are wider than the 
inside margins. Why? The outside margins are wider because they are the sides which will be 
bound in the book binding. This takes a minute to understand, because in you automatically 
suppose the inside margins in Word would be the “book binding margins” but that is not the 
way it comes out when printed. This makes sense when you understand that the second page 
will be printed on the back of the first. 



 
 

You can change the sizes of your margins, but it is recommended that you don’t, since the 
template is already set up for KDP Print requirements. However, if you decide to for some 
reason, you can change the margins by clicking on ‘Page Layout’ and then on ‘Margins’. Just 
like before, you will scroll down to the bottom of the dropdown and click on ‘Custom Margins’. 
This will pop up the Page Setup menu again, but this time with the ‘Margins’ tab selected. 

When the Page Setup menu pops up you will see fields which allow you to change the margins 
for the: 

• Top 

• Bottom 

• Inside 

• Outside 

• Gutter 
 



One of the first things that you will notice when looking at the fields is that the number in the 
fields are the exact same for both the inside and outside margins. That is because it is actually 
the ‘Gutter’ setting that affects the book binding width. So, for example, if you wanted to 
change the amount of space between the text and the binding you would change the number 
which appears in the ‘Gutter’ field. Again, it is best not to do this because the template is 
already pre-set for KDP Print’s submission requirements. 

 

It sometimes helps to view the pages side by side. That way you can get a better idea of what 
your reader will see (just remember that each second page will be printed on the back of the 
first). To view your document in this way, all you have to do is click on the ‘View’ tab and then 
on ‘Two Pages’. This will allow you to view two pages at once. 



 

Title, Rights, and Disclaimer Pages 
 
To begin formatting your book template, go to your books title page. Here you will see “Your 
Book Title” highlighted in yellow. These words are highlighted in yellow to indicate that these 
are the parts that you should customize for yourself. So, replace “Your Book Title” with your 
actual books title. You can take out the highlight simply by selecting all of this text before 
typing. 

 

After you insert the book’s title, look for other words that are highlighted and insert the correct 
information there too. As you go about changing the texts in yellow, be sure to format the 
fonts and font sizes as desired. Typically you will use a larger font size in your title than on your 
subtitle or on your author’s name. You also will generally want to use the same font though 
out a page. However, this is your book and there are no requirements to the type of fonts or 
font sizes that you use, so do with it as you please. 

On the ‘rights’ page, you can use either your name or your company’s name, whichever you 
feel is more appropriate. When you move on to your second title page, you can simply copy 
and paste the (already formatted) title information from your first title page, and then center it 
up in a way that looks good to you. 



 
 

Again, remember that this book template is just a guide to help you to format your book. You 
can change this in any way that you want to. You are welcome to use the copyright page and 
the disclaimer pages for your book if you like, or to add information as needed. For example, if 
you are publishing a medical book, you may need to add a medical disclaimer. You may also 
wish to seek legal advice to see if there is anything that you should add and/or subtract from 
the disclaimer or copyright pages. 



 

Font Selection & Size 
 
 
 

 
 
If you’ll notice, your template is set up in the ‘Georgia’ font. This is a type of serif font. Serif 
fonts are fonts which have semi-structural details on the ends of some of the strokes. They are 
widely used in printed materials such as in books or magazines. Therefore, they are usually the 
best choice for your book’s text. However, this is not required by KDP Print, so the choice is up 
to you. Other examples of serif fonts are ‘Gothic’ and ‘Times New Roman’. 

 
 

 
Fonts which do not have these details are generally referred to as non-serif fonts. ‘Arial’ and 
‘Verdana’ are examples of non-serif fonts. These fonts are used often used on web pages and 
other types of electronic media. So, as a general rule if you are publishing a physical book use 
serif fonts, since they are easier on the eye in print, but when publishing something like an 
eBook use non-serif fonts, since they are easier to read on electronic devices. 

You don’t have to follow this rule. If you are going to change the font, do so before formatting 
the rest of the text. To change the font you can do this easily by pressing Ctrl+A to select all of 
your text. Once the text is selected, click on your desired font in the drop down menu. Some 
people use the same font in the title pages as in the rest of the text, but it is okay if a different 
type of font is used here. 



 
 

In the template the size of the font is 14 point. A 12 or 14 point book is standard for most texts. 
Anything larger will look amateurish; generally the only time you will see texts with anything 
over a 14 point font is in children’s books. On the other hand, a book written in a font with less 
than a 12 point font may be hard for some people to read. 

If you need your book to be a little longer, one thing that you can do to expand it is use a larger 
font. There are other tricks you can use to ‘stretch out’ your book if you are short on content. 
So, don’t use a bigger font size than 14, even if you need you only need to add a few more 
pages to your book. Remember that the font on your title page should be larger than that of 
the rest of your text. Go ahead and fix the fonts and their sizes before continuing to format 
your manuscript any further. 



 

Creating Chapters & Headings 
 
By now you should have inserted your title and the other information needed within the first 
few pages of the book. You should have also chosen the fonts that you wanted to use 
throughout your book. Now that all this is done, you can begin to separate the chapters and 
inserting the headers in the document where they are needed. 

 

The first thing that you need to do is scroll through your text and rid the document of any 
excess information that may have carried over from your first draft. For example, if your book 
title still lies at the beginning of your text, you can delete that because you now have two title 
pages at the beginning of your template. Keep an eye out for other things to touch up on as 
well. As you do this, insert a page break after each chapter. You can do this by placing your 
cursor right in front of your chapter headings, clicking on the ‘Insert’ tab, and then clicking on 
‘Page Break’. 



 
 

As you can see, your manuscript is beginning to look more like a book. One thing that you can 
do to make your book look more professional is to separate your chapters so that the beginning 
of each chapter is ether on one side of the book or the other. To do this just, view your 
document two pages at a time, and format it so that all of the titles are on the right or the left. 
If you see one on the wrong side, simply add another page break. This will leave a blank page, 
but this doesn’t really matter the back of this page will just be blank when the book is printed. 



 
 
 
 

Once you have the manuscript completely formatted, go to each of your chapter headings and 
assign H1 tags to each of your chapters. You can do this by highlighting your chapter’s title, 
clicking on the ‘Home’ tab, and then click on Heading 1. By doing this correctly, you can create 
a table of contents automatically on Microsoft Word. As you are adding these H1 tags, you 
should take a look at your chapter headings and edit them as you see fit. For example, if a 
chapter heading looks messy or if any words are split up with hyphens, do what you can to 
make it look neater. 

 
 

 
 
 

One trick that you should take note of is how to pre-set your chapter heading with the H1 tags. 
Simply right-click on your ‘Heading 1’ under the ‘Home’ tabs and click ‘Modify’. This will allow 
you to choose the size, font, text align, etc. that you want. Once you have selected the settings 
click ‘OK’ and now every time you assign an H1 tag to a chapter heading, the style will change to 
match with the others. This can really save you a lot of time. 



 
 



 

Adding Images to Your Manuscript 
 
 

 
Adding images to your book’s manuscript is easy. Doing so will add value to your book, 
interest, and information to your book. Don’t be afraid to get creative in adding, editing, or 
modifying images, however only a few images are needed to really make your book look 
professional. 



 
 

To add a picture to your text, simply, place your cursor wherever you want to place the image, 
then go to the ‘insert’ tab, click on ‘picture’. This will allow you to search your computer’s files 
for pictures or go to the file which contains the picture that you want. The image will then 
appear, and if you wish to edit your picture double clicking on the image and some formatting 
options will appear. 

 



One thing to remember when adding images to your book is that color images can really add to 
the cost of printing your book. Sometimes, colored pictures can even double or triple your 
printing costs. One way to remedy this is to change your color image to grayscale image. To do 
this, follow these steps: 

• Double-click on picture, and you will see that a new tab pops up in Word. 

• On the top left hand side, in the ‘adjust’ category, click on ‘recolor’. 

• A dropdown menu will pop up with various options, simply choose grayscale. 
 
 

 
This still makes your book look better than it would without a picture, but does not add to the 
cost of having your book printed. This trick works with most books, and in reality, unless you 
are writing a book on photography or the like, it is really not worth the extra costs to have color 
images in your book. 

Once you have inserted the picture that you want, take time to resize the image and center it 
up. When your resize your picture, be careful not to make it so big that the picture no longer 
has a good resolution. Chances are, if it looks good to you, it will look good to your readers as 
well. 

Keep in mind that when you add an image or images to your book, this is going to add to your 
length. It will also cause changes in your formatting. You may have to go through your text 
again to make sure things are still formatted the way that you want them. You will probably 
have to put in a new page break or two, at least. 



 

Customizing & Adding Value to Your Book 
 
 

 
You should take the time to add information about you and your business to your book. This is 
especially important if you are writing one of the “ultimate business card” types of books. One 
way to add value to you book is to add testimonials to your book. This adds social proof to your 
book and contributes to the ultimate goal of the book – to let people know that you are an 
expert in what you do as well as an authority in your field. 

Writing an ‘About the Author’ section will help people know who you are, what you have been 
successful in, and why you are the right person for the job. A Forward to your book should also 
be added. This can be written by you, but it would come out better if you reach out to a 
colleague in your field or a mentor of yours and ask them to help you promote yourself by 
writing a Forward for you. Be sure have them include a message about how trustworthy you 
are and how much clients can benefit from hiring you. 

You should also take advantage of previously-written works about you or your work. For 
example, if you have an article in a trade magazine, you should add this to your book. This 
contributes to your image as an expert. Other examples works which can be added include: 

• Local articles about you or your work 

• Magazine articles you’ve contributed to 



• Information from your own website or blog 

You can add these as chapters, articles, or appendices. This shows that you are not only a 
published author in your field, but that people seek you out to contribute to your field. This 
type of content will not only increase the value of your book, but allow you flaunt your 
accomplishments. In other words, anything that contributes to your image as an expert should 
be added into your book. If you have not already done this, do so before moving forward with 
your book’s formatting. 



 

Monetizing Your Book with “Book Hooks” 
 
One thing that you can, and should, add to your book is a “book hook”. A book hook is simply 
little blurb you can add into your book’s text that indicates how they can connect with you 
and/or get more information about you and the services you offer. It can include information 
about: 

• Your blog 

• Your website 

• Your Facebook page 

• Other books you have written 

These should be little calls of action which lead people from the page to the computer, to the 
phone, and so on. You want to catch people’s attention, and people who are interested should 
be informed about how to find out more; however you do not want to overdo this by placing 
this in your book too many times. You simply want to inform people of how they can reach out 
to you. Keep in mind, however, that these should be place appropriately. 

 



The following is an example of a “book hook” targeting people who need help getting their 
website better exposed: 

I can help you connect with potential customers in your area that are looking for 
your services online. If you’d like a free 15 minute consultation to learn how you 
can get your website on page one of Google, please make an appointment with 
my office manager at XXX-XXX-XXXX. 

Again, use your best judgment when inserting these “book hooks. They should fit well into the 
context of what you are saying, and fall in well with the text that comes before or after them. 
Also, it is best if they address a need of a person who may be reading the content. You can 
sprinkle a few of these throughout the book, but no more. Remember that if you sound like a 
salesman or you place to many of these in your book, you will end up turning people away. 



 

Your About the Author Page 
 
 

 
Your ‘About the Author Page’ is the most important page in your book. This is the place where 
you really have an opportunity to shine. Here you should allow the reader to learn about you 
as a person, inform them about your accomplishments, tell them about your family, and inform 
them of other works that you have written. You should also include a professional-looking 
picture of yourself here. 

This is also your money page. It gives you a great opportunity to include information on where 
to find more of your work, learn more about you, or how to get in touch with you. If you are an 
author by trade, be sure to include where they can go to purchase more of your work or how to 
find your Amazon ‘Author Central’ page. If you are writing an “ultimate business card”, then 
your ‘About the Author’ page should be geared more towards how to the reader can benefit 
from your services and how they can get in touch with you to receive your services. 

No matter what type of book you have, be sure to include some type of ‘call to action’ 
statement. A call to action statement is simply a statement which basically tells your readers to 
‘go here and do this Now!’ Don’t be afraid to be explicit about this. 

Inside the book, your ‘book hooks’ should simply be suggestions about where the reader can go 
to learn more. When you use these ‘book hooks’ throughout your text, you don’t want to come 
off as salesman-like. However, your ‘About the Author’ page is different. It is meant to be a 
sales page, and you should feel free to be blatant in the way you offer your services or boast 
about your other books. 



People are used to finding ‘call to action’ statements in ‘About the Author’ pages. In fact, 
people generally know that if they are interested they can turn to the ‘About the Author’ page 
to find out more. If there is someone who loved your book and wants to purchase another 
book from you or purchase your services, then you should absolutely give them the opportunity 
to do so. In turn, you should take advantage of your opportunity to attract more people to your 
work. 

 

 

The ‘About the Author’ page in the picture above can serve as a good example about how yours 
should be put together. It reads as follows: 

 
 

About The Author 
 

Author, consultant, and online marketing pro Jay Boyer specializes in helping 
entrepreneurs and small businesses gain a competitive advantage in their local 
market – both online and off. He helps these businesses get “found” online, 
ensures that they never run out of leads, and helps them to transform potential 
clients into lifetime customers (and raving fans!) 

If you are serious about improving your own business’ bottom line, and would 
like to schedule a free consultation to see how Jay can set a comprehensive 
online marketing campaign for your company, you can contact him by leaving 



you name, telephone number, and email address at 
http://www.smallbusinessmarketingstrategies.org/ or by leaving a voicemail at 
XXX-XXX-XXXX. 



 

Generating a Table of Contents 
 
 

 

If you have followed the steps laid out for you in this video training series, then 
Congratulations! Your book’s manuscript is complete. You should still take one last look, just to 
make sure that everything is up to par, especially if you have added in anything throughout this 
process. If you see anything out of place or that isn’t visually appealing, take a moment to fix it. 

Once everything is edited and well formatted, you are ready to make your table of contents. 
This will be based on the page breaks and H1 tags that you put in place earlier. So, before 
creating this table, make sure that your entire page breaks and H1 tags are in place. This way 
the page numbers listed will be correct. 

In order to create your table of contents, create two blank pages directly after your second title 
page. You can do this by inserting two page breaks here. The first of these two blank pages will 
be where your table of contents will be placed. 



 
 

Place your cursor in the blank page, then open up the ‘References’ tab. On the left hand side, 
you will see a table of contents icon. When you click on this, a dropdown menu will pop up, 
allowing you to select from a number of different styles. Select one and your table of contents 
will be generated automatically. 

Your table of contents may have some mistakes, so check over it. For example, if you spaced 
out your chapter headings in order to make them appear more balance, then there might be 
some excess spaces in the table of contents. You may also want to change the Table of 
Contents heading to match up with the rest of the text; you may decide to make the font larger 
in your table of contents as well. 



 
 

After your table of contents is complete, your manuscript is finished! You will want to save this 
as both a Word Document and PDF. As a word document, you can still go back and edit it. This 
way you can go back and make changes if you need to. You will be saving it as a PDF as well 
because this is the format you will use when submitting it. You work is now ready to be 
published! Continue on to the next video series in order to learn how to submit your 
manuscript to KDP Print. 

 



 


